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In this section:

■■ Creating work resources quickly in the 
Gantt Chart view

■■ Creating resources using the Resource 
Sheet

■■ Modifying resources

■■ Entering resource holidays

■■ Assigning work resources to a task

■■ Adjusting the work, duration, and 
assignment units for a task

■■ Assigning material resources to a task
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■■ Resolving overallocations

■■ Deleting resources

Assigning and 
managing 
resources

7
Resources are required in order to complete tasks on projects, and once 

resources are defined, they need to be assigned to tasks. There are 
three resource types: work, material, and cost. Work resources are used 
to track work and its related cost, material resources are used to track the 
materials used and their cost, and cost resources are used to track other 
independent costs.  

When you are adding work resources to a project schedule, it’s pos-
sible to add them quickly in an ad hoc manner; this can be useful if the 
resources are assigned to a task full time or if they are used only as an 
indication of responsibility or ownership of a task. In such an instance, one 
can assume that the monitoring of workloads or costs is not of significant 
concern to the project manager. At other times, when workloads and costs 
are of importance, then resources should be planned carefully and an 
understanding of the correct use of work, material, and cost resources is 
required.

Not all projects will require resources on them. Sometimes it’s sufficient 
to just define what needs doing, how long it will take, and in what order 
tasks need to be completed. If your project falls into this category, you can 
skip this section.



Create work resources quickly using the Gantt 
Chart view
1	 In the View tab, click the Gantt Chart view.

2	 Drag the vertical splitter bar to the right to reveal the Resource 
Names column.

3	 Type the resource name into the field, thereby both creating the 
resource and assigning it to the task.

Creating work resources quickly in the Gantt Chart view
Use this option if you are not concerned about tracking costs 
or other resource information and your goal is to quickly assign 
resources to tasks and see these assignments in the Gantt Chart 
view. You might not be interested in the workload that the 
resource has. Instead, you are concerned with the responsibil-
ity or ownership of the task. When resources are created in this 
manner, Microsoft Project will assign the project calendar and 

default standard hourly rate to the resource. Using this method 
to create resources also creates the assignment between the 
resource and the task, and therefore, a work value for the task is 
calculated based on the task duration. Only work resources can 
be created using this method because the work resource is the 
default resource type. Once a resource has been entered, the 
same resource may be assigned to multiple tasks. 

21

3

CAUTION  Do not assign resources to summary tasks; doing so 
causes Project to calculate work values at the summary task 

level.

TIP  Assigning resources to tasks creates work on the task. By 
default, a one-day duration task with a resource assigned to it 

using the method described above will create eight hours of work if the 
project calendar represents an eight-hour day. To see the work value, 
insert the Work column into the table.

98  Creating work resources quickly in the Gantt Chart view: Create work resources quickly using the Gantt Chart view
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Changing a resource’s working time 
When a resource is created, the resource’s calendar is copied 
from the project calendar. Therefore, the resource’s calendar 
contains the same working and nonworking details as the 
project’s calendar.  

If a resource works a different number of hours, or even a 
different shift pattern from that defined by the project calen-
dar, then the resource’s calendar might need to be modified 
to reflect the resource’s working pattern.  

Once we understand each resource’s working time and 
have set it accordingly, we need to define how much of the 
resource’s working day can be classified as productive time. 
Productive time is time that can be spent working solely on 
a project, and nonproductive time is everything else, such as 
company meetings, staff training, and so on. Some organiza-
tions ignore nonproductive time if it’s less than four hours 
per week, and track only significant portions of nonproduc-
tive time, such as holidays or training courses. Other organi-
zations assume that resources are productive for 80 percent 
of their working week, so a day is lost per week doing 
“admin” type tasks.  

The amount of productive time that a resource is available 
is defined by the Max Units value for a resource. If it’s suf-
ficient that your work estimates include admin time, such as 
answering phones and so on, you can leave the Max Units for 
each resource at 100 percent. If, however, you want to set a 
resource’s productive time to be less than 100 percent, you 
can set the resource’s Max Units to the value you choose.

Whether you use the concept of productive time or not often 
depends on how accurate your work estimates need to be.

In addition to the Max Units settings you choose, you might 
also want to enter larger periods of nonworking time for 
each resource—for example, holidays or training. These 
periods are entered as calendar exceptions for each resource, 
and Project uses these calendar exceptions when a resource 
is assigned to a task. The effect of the exception will depend 
on the task mode (Auto Scheduled versus Manually Sched-
uled) and if Auto Scheduled, the task type (fixed units, work, 
or duration).
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Create a resource using the Resource Sheet
1	 Select the Resource Sheet by clicking the Resource Sheet shortcut in 

the status bar.

Creating resources using the Resource Sheet
The Resource Sheet is a view within Project that allows the user 
to view, create, and edit resources and resource information. 
You can access the Resource Sheet view from the View tab or 
from the Status Bar (it’s the fourth icon in the View Shortcuts 
area).

Ideally, you should create resources on the Resource Sheet 
before assigning them to tasks. This method is more formal 
than the ad hoc method of creating resources by typing their 
names directly into the Resource Names column on the Gantt 
Chart view, and it allows for additional entry of resource 
information, such as resource calendars, resource rates, email 
addresses, and so on. Adding resources through the Resource 
Sheet implies a higher level of project management formality 
and competence. 

Three types of resources are available in Project: 

■■ Work resources that are resources or pieces of equipment 
that perform work to accomplish a task 

■■ Material resources that are project consumables, such as 
paint

■■ Cost resources, such as travel expenses

Work resources will require at least a resource name, and, 
optionally, additional information may be entered, such as 
resource initials, standard rates, department, accounting code, 
and so on. The default resource type is Work. A work resource is 
generally thought of as a person (sometimes known as a named 
resource) or role, but the term can equally apply to equip-
ment that your organization hires or owns. For example, a work 
resource could be a cement mixer.

Material resources require a resource name and, optionally, a 
material label such as “each,” cost per unit, cost per use value, 
and accounting code. For example, coffee can be a material 
resource. Because it is priced per pound, coffee would have 
a label of “pound” and the cost would be $10.00. To create a 
material resource, set the type for the resource to “Material.” 

Cost resources require only a name and the resource type set to 
“Cost.” For example, a cost resource could be airfare.

1

(continued on next page)
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2	 Click the Resource tab.

3	 Click the Add Resources button.

4	 Select Work, Material, or Cost Resource from the menu.

5	 Overtype the <Resource Name> text with the resource name and 
complete the other details as necessary. 

Create a resource using the Resource Sheet 
(continued)

TIP  Adding a standard rate for a material resource allows the 
cost of the material to be calculated based upon the quantity 

used. If the standard rate is left at $0.00, the cost of the material will be 
zero. The value of a cost resource is entered when the assignment is 
created. 

TIP  You can easily create work resources that represent an 
organization, group of people, or role by typing in the repre-

sentative name—for example, Fabrikam Inc., Finance, or Account 
Manager. This is useful if you want to identify responsibility for a task 
away from a named resource to a function or group of people, but it 
can have implications if you are trying to track the workload and costs 
associated with that task. This is also known as a generic resource. 
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Modify a resource using the Resource 
Information dialog box
1	 Select the Resource Sheet by clicking the Resource Sheet shortcut in 

the status bar.

2	 Click the Resource tab.

3	 Select the desired resource by clicking the resource ID in the row 
header.

4	 Click the Information button to open the Resource Information 
dialog box.

Modifying resources 
You might need to modify resource details, including the 
resource’s availability, the resource’s standard rate, email details, 
and so on. You can modify resource details by editing the field 
directly in the Resource Sheet (if the field you want to edit is 
not available, you will need to insert it), or you can open the 
Resource Information dialog box to access the fields.  

The values that can be modified depend on the type of resource 
(work, material, or cost). For example, an email address is not 
applicable for a material resource.

1

3

2 4

(continued on next page)
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5	 Change the desired values and click OK.

Modify a resource using the Resource 
Information dialog box (continued)

TIP  Project integrates into Lync, enabling you to see the 
online status of resources within your contact list. Clicking the 

Resource Name in the Resource Sheet will display the resource’s Lync 
contact information.

TIP  You can quickly open the Resource Information dialog box 
by double-clicking the resource ID or any place in the row for 

the resource.
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Change the Max Units for a resource
1	 In the View tab, click Resource Sheet.

2	 Change the Max Units for the desired resource.

Changing the maximum units for a resource
The amount of productive time that a resource is available is 
defined by the Max Units value for a resource. If it’s sufficient 
that your work estimates include admin time, such as answering 
phones and so on, then you can leave the Max Units for each 

resource at 100 percent. If, however, you want to set a resource’s 
productive time to be less than 100 percent, you can set the 
resource’s Max Units to the value you choose.

2

1
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Change a resource’s working day
1	 In the Project tab, click the Change Working Time button.

2	 Choose the resource whose working day you would like to change.

3	 Click the Work Weeks tab and highlight the appropriate week.

4	 Click the Details button.

5	 Edit the specific working times for the work week.

6	 Click OK.

7	 Click OK to exit the remaining dialog boxes.

Changing a resource’s working day
The amount of time that a resource is potentially available is 
defined by the resource’s working calendar. When a resource 
is created, that resource inherits a copy of the project calendar 
(including any exceptions to the standard working week). If the 

resource works a different number of hours from those defined 
in the project calendar or a different shift pattern, then you 
might want to update the resource’s calendar to reflect this.

3

1 2 4
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CAUTION  Changing the start time for a resource away from 
the default (8:00 AM) can have scheduling consequences when 

multiple resources are assigned to the same task.  
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Enter a resource’s holidays
1	 In the Project tab, click the Change Working Time button.

2	 Choose the Resource whose holiday you wish to enter.

3	 Enter the holiday details on a new line in the Exceptions tab.

4	 Click OK.

Entering resource holidays
One of the biggest impacts on a project is resource availability, 
or, put more correctly, lack of it. It’s important that, as a project 

manager, you track your resource’s planned absences so that 
Project will not schedule the resource to work on vacation.

3 4

21

TIP  If the resource is highlighted in the Resource Sheet when 
the Change Working Time button is selected, the resource will 

already be selected when the Change Working Time dialog box is 
displayed.

TIP  The minimum period you are able to enter for a vacation 
is a single day.
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Setting up a view to assign resources
Much of what we do in Project requires us to be in the right 
view, at the right time, in order to see the right information. 
When we assign resources, this is no less important. When 
assigning resources, I set up my view as follows:  

Insert the columns “Type,” “Effort Driven,” and “Work” into 
the entry table on the Gantt Chart view.

Check the Details check box in the View tab and select the 
Task Usage view. Within the Task Usage view, insert the 
column “Assignment Units.”

I am then able to navigate through the task list in the top 
portion of the screen and view the assignment details for 
each task in the lower portion of the screen. 

You can make changes to Work, Duration, or add or remove 
resources for a task in the top portion of the screen. When 
any of these changes are made, Project displays a SmartTag 
in the top left-hand corner of the cell where you have just 
made the change. Clicking the SmartTag allows you to review 
the calculation that Project has chosen and provides you with 
the option to change Project’s decision. Changes to individual 
assignments, including work or assignment units, can be 
made in the lower portion of the screen.

Remember that a view can be saved. To do so, click the 
View tab and select the drop-down menu on the Gantt 
Chart button. I typically name my saved view “Resource 
Assignment.”

Effort Driven, task Type, 
and Work columns added

View saved
as Resource
Assignment view

Assignment and
Peak units showing
for each resource

Task Usage view
showing in lower 
half of the screen
SmartTag providing 
additional scheduling 
options

Peak units visible
in the details
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How does Project assign work?
Where one or more work resources are assigned to a task, 
Project uses the following formula for each assignment: 

	 work = assignment units × duration

Work defines the effort, or number of hours, required to 
complete a task.

Assignment units define what percentage of their working 
day each resource can devote to a task. The assignment units 
will initially be set to the Max Units value defined for each 
resource, but this value can be modified per resource and per 
assignment.

Duration defines the total number of days between the start 
and end of a task. By default, duration is displayed in days in 
Project, where one day is equal to eight hours (this is depen-
dent on the calendar options for the project).

When there is a single resource assigned to a task full time, 
the formula is very simple. For example, a two-day duration 
task (which is equivalent to 16 hours) assigned to a resource 
who works full time on the task will calculate a work value of 
16 hours (assuming a calendar of 8 hours per day) (work = 16 
hours × 100%).

The scheduling process in Project becomes more complex 
when either of the following two combinations occurs:

■■ Resources do not work full time on a project. Instead, 
their availability is reduced (for example, if they are 
deemed to be productive for 80 percent of the time, 
their Max Units would be set to 80 percent, and their 
initial Assignment Units would also equal 80 percent).

■■ If, having made an assignment, that assignment is then 
modified, modifying the assignment could include any 
of the following:

■■ Changing the duration

■■ Changing the work

■■ Changing the assignment units

■■ Adding one or more resources or removing one or 
more resources from the task

■■ Any combination of the above

Let’s take a look at the first scenario. If a resource’s Max Units 
is set to 80%, work = duration × 80%, therefore work = 16 × 
80% = 12.8 hours, or put another way, working at 80% pro-
ductivity over two days allows us to accomplish 12.8 hours of 
work. Again, this is fairly simple to understand.  
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We can make it a little more complex by modifying either 
of the work, duration, or (assignment) units. Let’s assume we 
modify the Work value from 12.8 hours to 16 hours, Project 
has the option to do one of two things. It can increase the 
units from 80 percent to 100 percent, leaving the duration at 
2 days (16 hours); or it can increase the duration from 2 (16 
hours) to 2.5 days (20 hours), leaving the units at 80 percent.  

Exactly what Project will do depends on several factors. First, 
if the task is manually scheduled, the duration will not change 
and the units will increase to 100 percent. If the task is auto 
scheduled, Project uses a task field called Type to determine 
which variable to fix and which to change. The three avail-
able values for the Type field are Fixed Units, Fixed Work, 
and Fixed Duration (the default). Project “fixes” the variable 
defined by the task type and changes the second variable 
when the third variable is modified. Therefore, for an auto 
scheduled task with the task type set to the default setting of 
Fixed Units, increasing the work from 12.8 hours to 16 hours 
will increase the duration to 2.5 days, leaving the units “fixed” 
at 80 percent.

Taking the scenario a little further, we might want to add 
an additional resource to the task. Assuming we have the 
following task, where there is a single resource completing 
16 hours of work in 2.5 days duration, the following options 
could occur when another resource is added to the task:

■■ The second resource works at the same rate as the first 
resource (that is, 80 percent) over the same duration. 
Hence the work value doubles (duration = 2.5 days, 
work = 32 hours).  

■■ The second resource works at the same rate as the first 
resource (that is, 80 percent), but shares the workload 
of the first resource. Therefore, the work value stays 
the same (16 hours) but the duration decreases (1.25 
days).

■■ The duration and work values stay the same (2.5 days 
duration and 16 hours work), but the resources work 
fewer hours per day, so their units are reduced from 80 
percent to 40 percent.

Finally, there is another field, called Effort Driven, that affects 
auto scheduled tasks. You can set this field to either Yes or 
No (the default is No). If the task is effort driven (the value 
is set to Yes), when an additional resource is assigned to the 
task, the work value for the task is split equally across the 
resources assigned to the task. Note that fixed work type 
tasks are deemed to be effort driven by default.

As you can see, getting the correct values set for Work, Units, 
and Duration for a task involves a little thought and practice. 
Luckily, Project allows us to set a view that includes all of the 
fields we need to see in order to successfully manage the 
variables of Work, Units, and Duration for each assignment. 
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Assign a single work resource to a task
1	 In the View tab, select the Gantt Chart view.

2	 Drag the vertical splitter bar (click and hold the bar) to the right to 
reveal the Resource Names column within the entry table.

Assigning a single work resource to a task
Assigning work resources to a task creates work values for the 
task. The simplest way to assign resources is directly within the 
Gantt Chart view. This creates a simple assignment where the 
work value is calculated using the following formula: work = 
units × duration. 

By default, the units for a single resource is 100 percent and, 
therefore, the work calculated is simply the number of days 
duration multiplied by the number of hours in a working 
day (by default, eight hours). I call this the default assign-
ment (where neither the work nor assignment units have been 
modified).

If you have already created resources by typing their names 
directly into the Gantt Chart view, then you have already 
assigned your resources to tasks using the default assignment.

When working with assignments, it’s a best practice to have 
both the duration and work column visible in the entry table, 
and I have already done this for the remaining screen shots 
in this section. For information on how to add columns into a 
table, see Section 2, “Getting started with Project 2013,” or Sec-
tion 3, “Getting the Project basics right.” 

1 2

(continued on next page)
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3	 Click in the Resource Names cell for the desired task and select the 
resource using the drop-down menu. 

4	 Review the value in the work column to ensure that the calculated 
value matches your expectations.

3

4

Assign a single work resource to a task (continued)

TIP  If you are using Lync to communicate with your coworkers 
and resources, their online status will appear next to their name. 

To use Lync, enter the email address for the resource in the Resource 
Information dialog box.

TIP  If the Work column is not displayed, you can insert it by 
clicking the Format tab and then clicking the Insert Column 

button.
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Assigning multiple work resources to a task
Making multiple assignments on one task raises questions of 
how the work should be spread among the resources—for 
example, if a five-day duration task has a single assignment, the 
assignment will total 40 hours of work for the assigned resource 
(this is the default assignment). If a second resource is then 
assigned to the task, Project has three options to choose from:

■■ Spread the existing work between the two resources 
(resulting in 20 hours of work each), reduce the duration 
to 2.5 days, leaving the assignment units at 100 percent.

■■ Spread the existing work between the two resources 
(resulting in 20 hours work each), reduce the assignment 
unit for each resource 50 percent, leaving the duration at 
five days.

■■ Increase the total work to 80 hours (resulting in 40 hours 
work each), leave the duration at five days and the assign-
ment units at 100 percent.

The value that changes depends initially upon the task mode 
(Auto Scheduled versus Manually Scheduled), and if the task is 
auto scheduled, it will also depend upon the task type (of which 

there are three: Fixed Units [the default], Fixed Work, or Fixed 
Duration) and whether the task is effort-driven (definitions of 
these items are given in the sidebar “How does Project assign 
work?” on page 108). 

Reviewing and setting the task mode, and if applicable, the task 
type prior to assigning the resources is best practice. With all 
of these sophisticated components at play, it’s recommended 
to keep a watchful eye on both the duration, work, and assign-
ment unit values for a task while making changes. Luckily, 
Project makes this easy by providing the ability to insert the 
Work column in the table and to split the screen horizontally to 
display more detailed task information. For more information 
on setting up a view to contain all of these elements, see the 
sidebar “Setting up a view to assign resources” on page 107.

Remember, Project will use the formula work = units × duration 
to calculate the amount of work on an assignment. Where there 
are multiple assignments, the work values for each assignment 
are rolled up and summarized for the task.

1 2Assign multiple work resources to a task
1	 In the View tab, select the Gantt Chart view.

2	 Drag the vertical splitter bar to the right to reveal the Resource 
Names column within the entry table.

(continued on next page)
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3	 Select the row by clicking the task ID in the row header.

4	 Click the Details check box and make sure the task form is 
displayed.

5	 Within the Task Form, right-click the task form (in the lower pane) 
and select the Work view if it’s not already shown.

6	 On the task form, select resources from the drop-down list.

7	 Click OK.

8	 Verify that the work and units values are as you expected, both for 
the resources and the task.

543
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7

8

8

Assign multiple work resources to a task 
(continued)
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Adjust the work, duration, and assignment 
units for a task
1	 In the View tab, select the Gantt Chart view.

2	 Move the vertical splitter bar to the right to reveal the Resource 
Names column in the entry table.

3	 Select the row by clicking the task ID in the row header.

4	 Click the Details check box and make sure the task form is 
displayed.

5	 Within the task form, right-click the task form (in the lower pane) 
and select the Work view if not already shown.

Adjusting the work, duration, and assignment units for a task
When you are assigning multiple resources to a single task, 
the way that Project distributes the work might not be as you 
expected or wanted. The best way to make adjustments is to 
review the data available and then make changes as necessary. 

This might be an iterative process so don’t necessarily expect to 
get it right the first time. Remember that Project has an Undo 
command available on the Quick Access Toolbar, or press Ctrl+Z 
to undo the last command.

1 2
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43(continued on next page)
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6	 Adjust either the task work or duration fields or the resource work 
or units fields. If necessary, click OK to update the assignment after 
the amendments and verify that the work, units, and duration 
values are as you expect. Repeat as required until the values are 
correct.

6Adjust the work, duration, and assignment 
units for a task (continued)

TIP  The impact of the resource assignments and work values 
on the task is calculated only when the OK button is clicked.

CAUTION  The units value displayed in the form is the 
Assignment units value (this represents the initial assignment 

units value, which is not necessarily the current one used in the 
calculation work = units × duration); changing the Work value does not 
change this (initial) assignment unit value. This is as expected but can 
cause a lot of confusion. 
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Assign a material resource to a task
1	 In the Resource tab, select the Gantt Chart view from the drop-

down menu on the Team Planner button.

2	 Click the Assign Resources button to display the Assign Resources 
dialog box.

3	 Click the task that you want to make the assignment on.

4	 Verify that the selected task name is displayed within the Assign 
Resource dialog box.

5	 Type in the quantity of the required resource in the Units field.

6	 Click the Assign button.

Assigning material resources to a task
When a material resource is assigned to the task, the assign-
ment defines the quantity of the material used and conse-
quently the cost of that material, too. Material resources can’t 
be created on the fly in the same way that work resources can. 
Material resources always need to be created in the Resource 
Sheet before they can be assigned to a task. When material 

resources are assigned, the amount of material required is 
entered in the Units field. For this example we will use the 
material resource “coffee,” which was previously added to the 
Resource Sheet; as a reminder, the label for coffee is pound and 
the price is $10 per pound.

TIP  It’s possible to multiselect several tasks and assign the 
resources to those tasks at once.

TIP  If a standard rate has been entered for the material 
resource within the Resource Sheet, the cost of the assignment 

will be displayed.

1 3 4 5 62
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Assign a cost resource to a task
1	 In the Resource tab, select the Gantt Chart view from the drop-

down menu on the Team Planner button.

2	 Click the Assign Resources button to display the Assign Resources 
dialog box.

3	 Click the task that you want to make the assignment on.

4	 Verify that the task name is displayed within the Assign Resource 
dialog box.

5	 Type in the estimated cost for the resource on the task.

6	 Click the Assign button.

Assigning cost resources to a task
Cost resources are typically used to add cost to tasks without 
adding work hours or task duration. A typical cost that a cost 
resource would be used for is travel expenses. When the cost 

resource is assigned to a task, the estimated cost should be 
entered. 

1 2 3 4 5 6
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What is an overallocated resource?
Juggling resource demand and availability on a project is 
another key skill required of the project manager. Project 
2013 automatically highlights resources that are overal-
located and provides several features to help resolve the 
overallocations. 

When a work resource is assigned to a task, Project calculates 
the Peak Units value, which reflects the maximum work-
load that a resource has on an assignment. For example, if a 
resource is assigned 10 hours of work during a single eight-
hour day, the Peak Units field would equal 125%. The Max 
Units field is defined for each resource on the Resource Sheet 
and defines the maximum value that the resource is available 
during the current time period.

An overallocated resource is one where the peak units for 
any time period exceeds the max units defined for the time 
period—for example, two tasks running simultaneously with 
the same resource assigned could give 16 hours of work in 
an eight-hour day. Tasks with overallocated resources show 
a “red man” (  ) in the indicators column in the Gantt Chart 
view. 

There are many ways to view and review overallocations. Any 
resource that is overallocated is always displayed in red in the 
Resource Sheet and other resource-centric views. An Overal-
located filter is available to quickly identify those resources 
that are overallocated. In the Team Planner both resources 
and the conflicting assignments are highlighted in red, and 
on the Gantt Chart view the “red man” is displayed to indi-
cate tasks where an overallocation exists.
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Resolve overallocated resources using the 
Task Inspector
1	 On the Gantt Chart view (or any task-based view), scan the screen 

for any tasks with the red man icon.

2	 Hover over the red man icon and right-click to show the menu 
options.

3	 Select Fix In Task Inspector.

4	 Read the specific message regarding the overallocation; the overal-
located resources are displayed below the message.

5	 Select the appropriate action to resolve the overallocation. 

Resolving overallocated resources using the Task Inspector
The Task Inspector button shows both warnings and sugges-
tions for each task. Turning it on displays an additional section 

of information for each task and is helpful when trying to 
resolve overallocated resources.

1 2
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4

5

TRY THIS  Select the Task Inspector from the Task tab by 
clicking the Task Inspector icon ( ) in the task group. 

TIP  You can disable warnings for the task by clearing the 
Show Warning And Suggestion Indicators For This Task check 

box.
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Resolve overallocations using the Team 
Planner
1	 In the View tab, select the Team Planner button. 

2	 Drag the task up or down to change the resource the task is 
assigned to. 

Resolving overallocated resources using the Team Planner
The Team Planner view is available in the Professional version 
of Project, and it allows you to see at a glance which tasks have 
been assigned to resources. By dragging the tasks between 
resources you can change existing assignments, remove a 
resource, from a task, or assign currently unassigned tasks to 
resources. By dragging the tasks left or right, you can change the 

dates on which the tasks are scheduled to occur. This is perfectly 
acceptable for a simple plan, but on a more complex plan with 
many dependencies and auto scheduled tasks, this can have 
major scheduling implications. The Team Planner is best suited 
to viewing and changing assignments between resources rather 
than rescheduling the start and finish dates of tasks.

CAUTION  If a task is moved outside of the original schedule 
dates, any dependent tasks will be affected. If the dependent 

tasks are manually scheduled, they might be marked with a potential 
scheduling problem in the Gantt chart. If the dependent tasks are auto 
scheduled, they will be rescheduled automatically and can therefore 
change the start and end dates on other tasks.

CAUTION  If the task is auto scheduled, dragging the task left 
or right will place a constraint date on the task, meaning that 

the task will be scheduled to start or finish on a specific date. Ideally, 
each project plan should have a minimal number of constrained tasks.

2
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CAUTION  Deleting a resource also deletes any assignments 
associated with the resource. If the project has been running for 

a while, then it’s likely that the resource has performed actual work on 
a project, in which case the actual work will also be removed, causing 
you to lose historical information regarding the tasks performed by the 
resource (a warning is shown confirming that you would like to remove 
the resource). If a resource has left the project, then instead of deleting 
the resource, it’s best practice to reassign the remaining work to 
another resource and append the word LEFT, followed by the date, to 
the resource’s name. This preserves any actual work or other values 
that are related to the resource.

2

1

Deleting resources
Sometimes resources are created that are not actually required 
or used. You should remove these resources from the project 
because they are not necessary.

Delete a resource
1	 In the View tab, click the Resource Sheet button. 

2	 Click the row heading to select the resource.

3	 Press the Delete key to remove the resource.
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formatting options for,  143
unlinking tasks and,  90
vs. manually scheduled tasks,  181

B
background color, changing,  138
Backstage view

accessing,  12
defining calendar options in,  44
description of,  12
exiting,  12
personal templates,  211
saving plans with,  53, 167

bars
formatting all,  142
formatting multiple,  140

Bar Style,  142
Baseline Duration field,  174
baseline fields,  174, 206
baselines

auto scheduled tasks and,  181
basics of,  174

Index
Symbols
24 Hours calendar, description of,  38
% Complete tracking,  177–178, 182, 184, 188
% Work Complete tracking,  177–178, 184

A
account information, viewing in Backstage 

view,  12
Actual Duration,  177–178, 190
Actual Finish date,  190
Actual Start date,  177–178, 190
actual work values,  193
Add A Place option,  167
Alt+Shift+Right shortcut key,  69
Arrow cursor icon,  33
“as is” date,  186
As Late As Possible constraint,  128
assignment-based views, information included 

in,  20
assignment information, choosing correct views 

for,  9
assignments

default value of,  110
formula for,  108
modifications to,  108

assignment units
adjusting,  114
defined,  108
displayed value,  115

As Soon As Possible constraint,  128
Author field,  48
AutoFilter, displaying,  27
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charts
burndown charts,  154
changing chart style,  155

Clear Filter button, adding to Quick Access 
Toolbar,  27

Clear Group button, adding to Quick Access 
Toolbar,  29

cloud-based services, saving projects to,  53
colors, changing,  138, 142
color scheme, changing,  142, 153
columns

adding deadlines with deadline 
columns,  124

autosizing,  34
Constraint Date/Type,  130
defined by tables,  20
description of,  11
hiding,  32
inability to delete,  32
inserting,  30, 111, 207
Marked column,  139
moving,  33
redisplaying,  32
resizing,  31, 34, 52
viewing additional,  207
viewing resources with,  107

commands
adding to Quick Access Toolbar,  18
adding to ribbon UI,  14
description of,  13

communication.  See reports
Comparison Report,  208
constrained tasks,  120
constraint dates

for auto scheduled tasks,  128
methods of entering,  130

Copy Report button,  152
cost reports,  150

cost resources
assigning to tasks,  117
creating,  100
defined,  100

costs, displaying currency symbol for,  50
Cost Variance,  206
critical path

calculation of,  147
displaying,  146

Ctrl+B (bold) shortcut,  138
Ctrl+F2 shortcut,  86
Ctrl+I (italic) shortcut,  138
Ctrl+U (underline) shortcut,  138
Ctrl+Z (undo) shortcut,  114
currency type, setting,  50
cursor icons

Arrow icon,  33
Move Cursor icon,  33

D
dashboard-style reports,  150
date format, changing default,  52
deadlines, adding to tasks with deadline 

column,  124
Default End Time,  45
Default Start Time,  45
Delete key, hiding columns with,  32
dependencies

abbreviations for,  88
adding external to auto scheduled 

tasks,  130
adding lag/lead time to,  92
changing type of,  88
default type,  88
types of,  84

dependency links, displaying,  148
dependency network, creating,  86

dependent tasks
changing start/finish dates and,  126
linking,  86
potential scheduling problem with,  120

detail tasks
described,  65
entering,  66
entering duration estimates for,  78
entering work estimates for,  81
updating,  178, 182

dialog boxes, displaying,  13
dialog launcher,  13
documents, managing in Backstage view,  12
driven successor tasks,  94
driving predecessor tasks,  94
duration

adjusting,  114
defined,  108

duration budget,  80
duration column,  66
duration estimates

amending,  196
elapsed time,  79
entering for detail tasks,  78
entering for summary tasks,  80
project closing and,  200
reviewing tasks with,  82

duration field, question mark (?) in,  82
duration variance,  206
duration vs. work,  77

E
Effort Driven,  109
elapsed time duration,  78, 79
emailing project schedules,  169
Estimated check box,  82
estimated flags,  82
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indenting tasks, effect of,  68
indicator column

blue check mark,  188
calendar icon,  133
green arrow icon in,  124

in-progress reports,  150
Insert Column button,  111
insert key shortcut,  71
Insert Task button,  71
italicize command,  138

L
lag times,  84, 92
lead times,  84, 92
legends, removing from report,  156
links, creating between dependent tasks,  86
local drives,  54
logos, adding to reports,  155
Lync

online status in,  111
resource contact information in,  103

M
man days/hours,  81
manually scheduled tasks

and Timeline view,  161
changing start/finish dates,  126
duration estimates and,  80
effect of new calendars on,  133
effect of resource assignments on,  109
formatting options for,  143
project preplanning and,  62
vs. auto scheduled tasks,  181

Marked column,  139
Marked Tasks,  139
Mark On Track button,  183, 186
material resources

assigning to tasks,  116

G
Gantt Bars,  196
Gantt Chart view

creating work resources in,  98, 110
description of,  11, 21
formatting all bars,  142
formatting multiple bars,  140
red man icon,  118

Gantt With Timeline view
choosing alternate default view,  52
description of,  10, 21

generic resources, creating,  101
green arrow icon,  124
Gridlines dialog box,  187
groups (grouping)

creating a custom group,  14
presenting data with,  20
selecting different groups,  28

H
holidays

defining in calendars,  42
entering for resources,  106
tracking nonproductive time,  99

Hours Per Day values,  45

I
icons

blue check mark,  188
calendar icon,  133
cursor icons,  33
green arrow icon,  124
red man icon,  118
task mode icons,  62

Inactivate button,  204
Inactive Tasks feature,  134
incomplete tasks, finding,  27, 200

estimates.  See duration estimates; See work 
estimates

Excel, creating visual reports in,  158
exceptions

defining,  42
holidays/training courses,  99
nonrecurring,  43
recurring,  42

Exception tab, setting exception recurrence 
pattern,  43

Export option, saving plans with,  53
external dependencies, adding to tasks,  130

F
F3 (remove filter) shortcut,  27, 147, 201
filters

finding incomplete tasks with,  200
Milestones filter,  202
presenting data with,  20
selecting different filters,  27
Unstarted Tasks filter,  204

finish date
changing,  126
entering for auto scheduled tasks,  128
vs. deadlines,  124
warning of delay,  125

Finish No Earlier Than constraint,  128, 130
Finish No Later Than constraint,  128
Finish to Finish (FF) dependency,  84
Finish to Start dependency,  84, 88
Finish Variance,  206
Fixed Duration,  109
Fixed Units,  109
Fixed Work,  109
fonts, changing,  138
Format Bar dialog box,  141
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Project Calendar.  See also calendars
assigning a different calendar,  39
setting up,  38

project data, choosing correct views for,  9
project level information, choosing correct 

views for,  9
project life cycle,  3
Project Online,  58
Project Overview, viewing and printing,  152
project plans

basics of,  2
comparing versions of,  208
definition of,  8
ensuring easy update of,  181
rescheduling to new date,  180
saving as templates,  210
saving to SharePoint,  166
synchronizing task lists with 

SharePoint,  168
updating,  178
updating entire project,  188
updating individual tasks,  182
updating per period,  192
updating with actual data,  190

Project Portfolio Management,  58
Project Professional edition, saving to 

SharePoint/Project Server,  53
Project Reports feature,  150
projects

changing default date format,  52
changing default view,  52
closing,  200–211
comparing versions of,  208
creating a schedule for,  62
definition of,  8
displaying task paths,  94
entering start date,  46
increasing viewing area,  16
life cycle of,  3

N
names/naming

milestone tasks,  66
modified views,  35

new tasks, inserting in schedule,  71
Night Shift calendar, description of,  38
nonproductive time,  99
nonworking days, in duration estimates,  78

O
Office Art shapes, formatting,  163
options

setting in Backstage view,  12
setting in calendars,  44

organizational holidays, defining,  42
outdenting tasks,  70
Outline Level,  68, 72
overallocated resources

explained,  118
resolving with Task Inspector,  119
resolving with Team Planner,  120

overview report,  150, 152

P
paths, tracking with Task Path feature,  144
PDF file format,  53, 57
Peak Units value,  118
personal templates,  211
Pivot Diagram,  158
Pivot Table fields,  158
PowerPoint, copying Timeline view to,  163
Predecessor column,  89
predecessor tasks,  62, 86, 90, 94, 144
predefined reports,  150
presentation styles,  142
productive time,  99, 104

creating,  100
defined,  100
standard rate for,  101

Max Units value,  99, 104, 108, 118
Microsoft Excel file format,  53
Microsoft Project 2013

aligning features with project phases,  3
built-in views,  20
coordinating work times in,  44
navigating in,  10
new features of,  6
reporting features in,  150
terminology used in,  8
user interface diagram,  9

Microsoft Project Plan file (.mpp)
default file format,  53
entities contained in,  9

milestone reports
printing,  156
producing custom,  151

Milestones filter,  202
milestone tasks

described,  65
entering,  66
formatting,  139
naming,  66
percent complete setting,  183
project closing and,  200, 202
updating,  178, 182

mitigation tasks,  134
modified views, saving,  35
monetary budgets, using work estimates 

with,  81
Move Cursor icon,  33
Move Task button,  180
Must Finish On constraint,  128
Must Start On constraint,  128
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assigning single work resources to 
tasks,  110

changing productive time available 
for,  104

changing working days for,  105
changing working time of,  99
creating generic,  101
creating using Resource Sheet,  100
creating work resources in Gantt Chart 

view,  98
definition of,  8
deleting unnecessary,  121
formula for assignment,  108
modifying,  102
planned absences for,  106
reassigning work,  121
relationship to tasks,  9
resolving overallocated,  118–120
specifying with filters,  20
types available,  100
updating work complete for,  177
viewing assigned,  107

Resource Sheet
creating resources with,  100
description of,  21
modifying details on,  102

Resource tab, location of,  20
Resource Usage view,  21, 177
ribbon user interface

adding commands to,  14
collapsing,  10
collapsing and pinning,  16
customizing,  10, 14
description of,  10, 13

rows, description of,  11

reports
adding logos to,  155
adding title to,  156
burndown reports,  154
Comparison Report,  208
creating visual reports,  158
customized,  151
dependency links,  148
displaying critical path,  146
emailing,  169
formal reporting features,  150
formatting bars,  140–143
formatting table area,  138
printing the project schedule,  156
sharing with SharePoint,  166
synchronizing task lists with 

SharePoint,  168
Timeline view,  160–165
viewing and printing,  152
viewing task path,  144

Report tab,  151
Reschedule Uncompleted Work To Start After 

date,  194
resource assignment, definition of,  8
resource-based views, information included 

in,  20
resource information

choosing correct views for,  9
dialog box,  102

resource list, definition of,  8
Resource Names column,  100
resource reports,  150
resources

ad hoc creation of,  100
arranged by groups,  20
assigning cost resources to tasks,  117
assigning material resources to tasks,  116
assigning multiple work resources to 

tasks,  112

managing in Backstage view,  12
overview of estimate setting for,  77
overview of task interdependency,  83
overview of task management in,  61
returning to from Backstage view,  12
saving,  53–54, 56, 58
selecting appropriate calendar for,  38
setting currency type,  50
setting properties of,  48

project schedules
emailing,  169
selecting views of,  20

Project Server 2013, saving projects to,  53, 58
Project Summary Task, displaying,  36
project title, adding to report,  156
project views, tracking updates with,  177
properties, setting,  48
public holidays, defining,  42

Q
question mark (?) abbreviation,  82
Quick Access Toolbar

adding Clear Filter button,  27
adding Clear Group button to,  29
adding commands to,  18
customizing,  18
description of,  10
moving position of,  19

R
red man icon,  118
red underlined tasks,  126
remaining duration

amending,  196
tracking concepts and,  178
updating tasks and,  190

remaining work,  192
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removing duration estimate for,  80
scheduling of,  67
tracking,  185
updating,  178, 182

T
table area

description of,  11
formatting,  138

tables
choosing additional,  26
displaying different tables,  26
presenting data with,  20
tracking updates with,  177

tabs, description of,  10, 13
task calendar, creating,  132
task-centric views,  9, 20
task columns, viewing,  11
Task Dependency dialog box,  89–90
Task ID number,  86
task information, choosing correct views 

for,  9
Task Information dialog box,  92, 124, 128, 

130
Task Inspector, resolving overallocated 

resources with,  119
task lists

definition of,  8
synchronizing with SharePoint,  168
viewing,  11

task mode
icons representing,  62
linking tasks and,  85

Task Name column,  66
Task Path feature,  144
task paths, displaying,  94, 144
tasks

auto vs. manually scheduled,  62
calendars and,  132

Standard calendar
description of,  38
working days included in,  40

standard rates, for material resources,  101
start dates

changing,  126
entering,  46
entering for auto scheduled tasks,  128
rescheduling,  180
verifying,  47

start/end times, matching to working 
time,  44

Start No Earlier Than constraint,  128, 130
Start No Later Than constraint,  128
Start to Finish (SF) dependency,  84
Start to Start (SS) dependency,  84
Start Variance,  206
Status bar

description of,  11
shortcuts available on,  22

status date
and rescheduling,  194
and updating,  188
setting/displaying,  186

Subject field,  48
subtasks

creating,  68
hiding while moving,  75

successor tasks,  86, 90, 94, 144
summary tasks

automatic bold font for,  138
collapsing,  75
creating by outdenting,  70
deleting,  76
described,  64
entering,  67
entering duration estimates for,  80
inactivation of,  135, 205
moving around the schedule,  74

S
Save As command,  53
saving

modified views,  35
projects,  53–54, 56, 58

scenarios, planning for varied,  134
schedule.  See also reports; See also baselines

comparing to baseline,  206
emailing,  169
inserting tasks into,  71
moving summary tasks,  74
moving tasks in,  72, 195
rescheduling,  194
setting baselines for,  172
snapshots of,  174
tracking concepts,  178

schedule data, effect of linking tasks on,  85
schedule mode

changing,  62
changing for individual tasks,  63
changing for new tasks,  63
defining default,  63
manual vs. auto,  62

schedule-related information, viewing,  9
scheduling problems, correcting,  126
scheduling styles,  142
screen resolution

selecting appropriate,  14
standard,  13

Set Baseline dialog box,  175
Set Interim Plan button,  175
SharePoint

saving projects to,  53
sharing reports with,  166
synchronizing task lists with,  168

SkyDrive,  56
SmartTags,  107
SS abbreviation,  88
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U
uncompleted work,  194
underline command,  138
Undo button,  76
undo command,  114
unlinking tasks,  90
Unstarted Tasks filter,  204
Update Project dialog box,  194
updates

for individual tasks,  182
rescheduling,  194
types of,  178

Update Work As Complete Through 
date,  188

V
vacations.  See holidays
variance,  206
variance fields, adding to table,  207
variances, calculation of,  174
View Bar

displaying,  24
display order in,  25
hiding,  25

views
accessing,  20
categories of,  20
changing default view,  52
default view,  10
for resource assignment,  107
predefined,  20
presenting data with,  20
printing reports from,  151, 156
returning to original,  156
saving,  107
saving a modified,  35
selecting for desired data,  9, 22
tracking with,  177

timeline view and,  160
undeleting,  76
unlinking,  90
updating,  178, 182, 184, 190, 192
work, duration and assignment units 

for,  114
work resources and,  110, 112

task synchronization,  166
Task tab, location of,  20
Task Usage view,  21, 177
Team Planner

description of,  21
red highlighted resources in,  118
resolving overallocated resources 

with,  120
templates, creating,  210
text, formatting,  162
Text Styles button,  162
Themes button,  153
Timeline view

adding tasks to,  160
copying to other applications,  163
customizing,  11
description of,  11
formatting,  162
printing,  164

Title field,  48
top-down planning,  80
top-down scheduling,  62
total slack,  147
touch-enabled systems,  6
tracking, basics of,  178
Tracking Gantt chart

baseline duration in,  174
description of,  21
enabling tracking with,  177
percent complete values in,  185
updating projects and,  188

Tracking table,  177, 188, 200

changing schedule for,  63
changing schedule mode of,  63
constrained tasks,  120
cost resources and,  117
critical path and,  147
deadlines for,  124
definition of,  8
deleting,  76
dependency links,  148
entering,  66
estimation reviews for,  82
external dependencies for,  130
filters and,  20
finding incomplete,  200
grouping with Work Breakdown 

Structure,  64
groups of,  20
inactivating,  204
inactivating/activating,  134
indenting as subtasks,  68
inserting new,  71
linking and,  85
linking dependent tasks,  86
material resources and,  116
moving summary tasks,  74
moving within schedule,  195
outdenting to summary task,  70
overallocated resources for,  118
planning for potential,  134
predecessors/successor tasks,  90
reassigning,  121
red underlined,  126
relocating with cut and paste,  75
reordering,  72
rescheduling to future date,  194
resources and,  9
setting as complete,  200, 202
start/finish dates,  126, 128
task management,  61
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work resources
assigning multiple,  112
assigning single,  110
creating in Gantt Chart view,  98
defined,  100

work value
adjusting,  114
displaying,  98

Work Variance,  206
work vs. duration,  77

View tab
location of,  20
selecting view with,  22

Visio Professional/Premium,  158
visual reports, creating in Excel,  158
Visual Reports feature,  150, 158

W
warnings, disabling,  119
weekend work, scheduling,  132
Windows 8,  6
Work Breakdown Structure (WBS),  64
work column, inserting,  81, 98
work estimates

amending,  196
entering,  81
project closing and,  200

working days, changing,  105
working time

changing,  99
coordinating with calendar,  44
defined,  108
verifying selected times,  40

working week, setting,  40
work reports,  150
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